Setting up your virtualized infrastructure can be a challenge. Your hardware must deliver great performance to support your present and future business needs, and your data must be available at all times to keep your business running. Maintaining high availability, where your solution keeps operating with little to no downtime even when hardware fails, requires extra hardware components for redundancy.

To simplify the process of selecting, ordering, and deploying such a setup, Dell created Dell 3-2-1 Reference Configurations, proven architectures designed to meet your needs. With Dell PowerEdge R720 servers powered by new Intel Xeon processors E5-2680, the latest Dell PowerConnect™ 6224 switches, a Dell EqualLogic™ PS6100XV storage array, and a Dell PowerEdge R620 management server, you can keep your data highly available while getting the performance you need, all with room to expand as your business grows.

We tested the Dell 3-2-1 Reference Configuration, and found that it could support up to 1,000 users accessing database, mail, and collaboration software simultaneously. Such a large workload didn’t monopolize all resources; plenty of headroom remained to support more users in the future. We also tested the configuration’s ability to keep data highly available; when we pulled the plug on one of the host servers, it failed over quickly, with little disruption for users.
HIGH AVAILABILITY MADE EASY

Your employees and customers expect your business applications and data to be available at all times. Any interruption—whether due to scheduled downtime for maintenance or a surprise hardware failure—causes your business to suffer. High availability infrastructures protect your data, applications, and your business. Running your critical applications in virtual machines (VMs) on a server cluster keeps the data available—if one of your host servers fails, the VMs on it will move to the other server and continue running with little interruption.

With Dell 3-2-1 Reference Configurations built on Intel Xeon processor E5-2680-based Dell PowerEdge R720 servers, Dell makes it easy to set up high-availability architecture that has the performance capabilities to support your growing business. By choosing a Dell 3-2-1 Reference Configuration, you benefit from Dell best practices and guidelines as they apply to configuring your virtual infrastructure. For our step-by-step guide to deploying your new infrastructure, see our companion configuration guide at http://www.principledtechnologies.com/clients/reports/Dell/R720_321_configuration.pdf.

Easy setup in 3-2-1

We set up the Dell 3-2-1 Reference Configuration, which comprises three servers, two switches, and one storage array. We created a cluster with high availability (HA) enabled and ran three common business applications each supporting 1,000 users in VMware® vSphere® VMs on the Dell PowerEdge R720 servers: Microsoft® SQL Server® 2008 R2 for database, Microsoft Exchange Server 2010 SP2 for email, and Microsoft SharePoint® Server 2010 for collaboration.

We found that the Dell 3-2-1 Reference Configuration could handle 1,000 users accessing the database, using email, and using SharePoint, with resources to spare for future growth.

Figure 1: Dell 3-2-1 Reference Configurations built on Intel Xeon processor E5-2680-based Dell PowerEdge R720 servers can run three business applications simultaneously for over 1,000 users.
After finding that the Dell 3-2-1 Reference Configuration could handle our real-world workloads, we pulled the plug on one of the host servers to make sure the configuration would continue to operate in the event of a complete server failure. When we did so, the database VM on the “failed” server failed over to the other PowerEdge R720 host server and continued to run with very little downtime for users—less than a minute. The Dell 3-2-1 Reference Configuration’s ability to recover and maintain high availability means your business can keep running even in the event of a server failure.

**WHAT WE FOUND**

We set up three VMs across our two Dell PowerEdge R720 host servers to house the applications—the database application ran on one server and the mail and collaboration applications ran on the other. Our goal was to run workloads simulating 1,000 users in each VM to verify the configuration could handle the desired user load. Because we wanted to maintain high availability, we needed to ensure that each server could handle the load without oversubscribing resources so that they could fail over if necessary. Additionally, we ran the workloads while simulating a failover event to demonstrate that a single host server would be able to maintain the same level of performance.

Figure 2 shows the results for average CPU utilization for each VM while the benchmarks were running, and Figure 3 shows the average resource utilization for the host servers. Lower numbers are better.

<table>
<thead>
<tr>
<th>Application</th>
<th>Average percentage CPU utilization</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQL Server 2008 R2 (VM #1)</td>
<td>19.1%</td>
</tr>
<tr>
<td>Exchange Server 2010 (VM #2)</td>
<td>30.5%</td>
</tr>
<tr>
<td>SharePoint Server 2010 (VM #3)</td>
<td>20.0%</td>
</tr>
</tbody>
</table>

*Figure 2: CPU utilization for the VMs on the two Dell PowerEdge R720 servers.*

<table>
<thead>
<tr>
<th></th>
<th>Average percentage CPU utilization</th>
<th>Average percentage memory utilization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host 1 (VMs #2 and #3)</td>
<td>4.6%</td>
<td>9.3%</td>
</tr>
<tr>
<td>Host 2 (VM #1)</td>
<td>7.1%</td>
<td>14.0%</td>
</tr>
</tbody>
</table>

*Figure 3: Resource utilization for the two Dell PowerEdge R720 host servers.*

As our results show, the servers handled the workload while maintaining resource usage standards for high availability, with room to spare for growth in the future. The VMs only used a fraction of the virtual CPUs, and as Figure 3 shows, the host servers had plenty of resources left over.
We chose workloads for each VM that would best test the capability of the configuration to support 1,000 users on each application. Figure 4 shows the benchmark we used to test each VM, along with the median result (of three runs) for each.

<table>
<thead>
<tr>
<th>VM</th>
<th>Test</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQL Server 2008 R2 (VM #1)</td>
<td>DVD Store Version 2</td>
<td>3,704 OPM</td>
</tr>
<tr>
<td>Exchange Server 2010 (VM #2)</td>
<td>LoadGen</td>
<td>PASS</td>
</tr>
<tr>
<td>SharePoint Server 2010 (VM #3)</td>
<td>WSSDW 1.0.0.0 Beta</td>
<td>PASS</td>
</tr>
</tbody>
</table>

Figure 4: Median test results.

For more information on how we set up the tests to verify the performance capabilities of our high-availability hardware setup, see the What we tested section.

To simulate our failover event, we removed power from one of the vSphere hosts, specifically, the server that was hosting the SQL Server 2008 R2 database VM while we were running the DVD Store workload. The cluster quickly detected the failure of the host server and automatically migrated the VM to the other host server. The server was able to re-establish connection and continue the workload with only a slight interruption, less than one minute. Furthermore, we measured the resource utilization on the single host server running all three VMs under workload stress and found that the average resource utilization was at 13.3 percent CPU and 16.1 percent RAM, with no observable change in performance.

**WHAT WE TESTED**

We created a highly available cluster using two Dell PowerEdge R720 servers and a Dell EqualLogic PS6100XV storage array. We then used VMware vSphere 5 to create three virtualized servers, each with 2 virtual CPUs and 4GB RAM, in the cluster to run the line-of-business applications: a database server running Microsoft SQL Server, a mail server running Microsoft Exchange Server, and a collaboration server running Microsoft SharePoint Server. To demonstrate that each VM could handle 1,000 users, we ran benchmarks against each VM simultaneously to simulate 1,000 users accessing data on each. We measured the performance of the three virtual machines over 30-minute test runs, and report the median of three runs.

For step-by-step instructions on how we tested, see Appendix B.

**Database testing**

We used the DVD Store Version 2 (DS2) benchmark to simulate 1,000 database users. DS2 is an open-source application that models an online DVD Store where customers log in, browse movies, and purchase movies. DS2 reports its results in orders per minute (OPM) that the server can handle.

We ran DS2 with a 0.3-second think time, so that each of our 20 threads represented 50 users (1,000 total) completing one order approximately every 15 seconds. The benchmark then uses a default value of three searches on average before
each order. We define a minimum acceptable score as 3,200 OPM, or 80 percent of the expected results (80 percent of 4 OPM times the number of users) to take into account variation in the number of searches the benchmark completed prior to each order.

For more details about the DS2 tool, see http://www.delltechcenter.com/page/DVD+Store.

Mail testing

To test the configuration’s mail server performance, we used the Microsoft Load Generator 2010 (LoadGen) benchmark, which performs tasks to simulate a standard user generating mail activity. We simulated 1,000 users and used the following settings:

- Mailbox Profile: 100MB mailboxes
- Action Profile: Average
- Client Type: Outlook 2007 Cached

LoadGen simulates the mail activity for the 1,000 users and then reports a PASS/FAIL rating, which is based on acceptable response times.


Collaboration testing

To simulate the traffic of 1,000 SharePoint Server 2010 users, we used the WSSDW 1.0.0.0 Beta test. This test creates sample data, populates the server with it, and simulates SharePoint Server users completing everyday tasks.

We used Visual Studio 2010 to execute the test workload, generating a realistic user workload where each of the 1,000 simulated users performed a task every three minutes. To do this, we set up the test to run 200 users with 36 seconds think time in between each of the various tasks. The test workload then reports a PASS/FAIL rating based on whether it was able to complete all of the tasks successfully.

For more details about SharePoint Server, see http://office.microsoft.com/en-us/sharepoint-server-help/.

WHAT THIS MEANS FOR YOU

With Dell 3-2-1 Reference Configurations built on new Intel Xeon processor E5-2680-based Dell PowerEdge R720 servers, you can easily select, order, and deploy a virtualized infrastructure that meets your needs. Selecting a proven architecture from Dell eliminates the time-consuming prospect of piecing together a highly available infrastructure and eliminates the potential for error in selecting and deploying hardware.

In our tests, the Dell PowerEdge R720-based configuration could support 1,000 users accessing multiple business applications, and still have resources to spare for future growth. The configuration also maintained high availability as expected — when we caused one server to fail, the VMs migrated to the remaining server and kept business applications running with little interruption to users.
### APPENDIX A – SERVER AND STORAGE CONFIGURATION INFORMATION

Figure 5 provides detailed configuration information for the servers in our configuration, and Figure 6 provides configuration information for the Dell EqualLogic PS6100XV storage array.

<table>
<thead>
<tr>
<th>System</th>
<th>Dell PowerEdge R720 (host servers)</th>
<th>Dell PowerEdge R620 (management server)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Power supplies</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total number</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Dell D750E-S1</td>
<td>Dell E750E-S0</td>
</tr>
<tr>
<td>Wattage of each (W)</td>
<td>750</td>
<td>750</td>
</tr>
<tr>
<td><strong>Cooling fans</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total number</td>
<td>6</td>
<td>7</td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>AVC DBTC0638B2V</td>
<td>Delta GFC0412DS</td>
</tr>
<tr>
<td>Dimensions (h x w) of each</td>
<td>2-1/2” x 2-1/2”</td>
<td>1-1/2” x 1-3/4”</td>
</tr>
<tr>
<td>Volts</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>Amps</td>
<td>1.20</td>
<td>1.82</td>
</tr>
<tr>
<td><strong>General</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of processor packages</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Number of cores per processor</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>Number of hardware threads per core</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>System power management policy</td>
<td>Balanced</td>
<td>Balanced</td>
</tr>
<tr>
<td><strong>CPU</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor</td>
<td>Intel</td>
<td>Intel</td>
</tr>
<tr>
<td>Name</td>
<td>Xeon</td>
<td>Xeon</td>
</tr>
<tr>
<td>Model number</td>
<td>E5-2680</td>
<td>E5-2660</td>
</tr>
<tr>
<td>Stepping</td>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>Socket type</td>
<td>LGA2011</td>
<td>LGA2011</td>
</tr>
<tr>
<td>Core frequency (GHz)</td>
<td>2.70</td>
<td>2.20</td>
</tr>
<tr>
<td>Bus frequency</td>
<td>8.0</td>
<td>8.0</td>
</tr>
<tr>
<td>L1 cache</td>
<td>32 KB + 32 KB (per core)</td>
<td>32 KB + 32 KB (per core)</td>
</tr>
<tr>
<td>L2 cache</td>
<td>256 KB (per core)</td>
<td>256 KB (per core)</td>
</tr>
<tr>
<td>L3 cache (MB)</td>
<td>20</td>
<td>20</td>
</tr>
<tr>
<td><strong>Platform</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Dell PowerEdge R720</td>
<td>Dell PowerEdge R620</td>
</tr>
<tr>
<td>Motherboard model number</td>
<td>00W9X3</td>
<td>07NDJ2X03</td>
</tr>
<tr>
<td>BIOS name and version</td>
<td>Dell 0.3.37</td>
<td>Dell 0.3.37</td>
</tr>
<tr>
<td>BIOS settings</td>
<td>Power Management set to OS Control</td>
<td>Power Management set to OS Control</td>
</tr>
<tr>
<td><strong>Memory module(s)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total RAM in system (GB)</td>
<td>64</td>
<td>32</td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Hynix HMT31GR7BFR4A-H9</td>
<td>Hynix HMT351R7BFR8C-PB</td>
</tr>
<tr>
<td>Type</td>
<td>PC3-10600R</td>
<td>PC3-12800R</td>
</tr>
<tr>
<td>Speed (MHz)</td>
<td>1,333</td>
<td>1,600</td>
</tr>
<tr>
<td>Speed running in the system (MHz)</td>
<td>1,333</td>
<td>1,600</td>
</tr>
<tr>
<td>Timing/Latency (tCL-tRCD-tRP-tRASmin)</td>
<td>9-9-9-36</td>
<td>10-10-10-37</td>
</tr>
<tr>
<td>System</td>
<td>Dell PowerEdge R720 (host servers)</td>
<td>Dell PowerEdge R620 (management server)</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------------------------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>Size (GB)</td>
<td>8</td>
<td>4</td>
</tr>
<tr>
<td>Number of RAM module(s)</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>Chip organization</td>
<td>Double-sided</td>
<td>Double-sided</td>
</tr>
<tr>
<td>Rank</td>
<td>Dual</td>
<td>Dual</td>
</tr>
<tr>
<td><strong>Operating system</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>VMware ESXi 5.0.0</td>
<td>Windows Server 2008 R2 SP1</td>
</tr>
<tr>
<td>Build number</td>
<td>515841</td>
<td>7601</td>
</tr>
<tr>
<td>File system</td>
<td>EXT3</td>
<td>NTFS</td>
</tr>
<tr>
<td>Kernel</td>
<td>5.0.0</td>
<td>ACPI x64-based PC</td>
</tr>
<tr>
<td>Language</td>
<td>English</td>
<td>English</td>
</tr>
<tr>
<td><strong>Graphics</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Matrox® G200e</td>
<td>Matrox G200eR2</td>
</tr>
<tr>
<td>Graphics memory (MB)</td>
<td>8</td>
<td>16</td>
</tr>
<tr>
<td><strong>RAID controller</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>PERC H710P Mini</td>
<td>PERC S110</td>
</tr>
<tr>
<td>Firmware version</td>
<td>21.0.1-0132</td>
<td>3.0.0-137</td>
</tr>
<tr>
<td>Cache size</td>
<td>1 GB</td>
<td>1 GB</td>
</tr>
<tr>
<td><strong>Hard drive</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>N/A</td>
<td>Dell MHZ2160BK G2</td>
</tr>
<tr>
<td>Number of disks in system</td>
<td>N/A</td>
<td>2</td>
</tr>
<tr>
<td>Size (GB)</td>
<td>N/A</td>
<td>160</td>
</tr>
<tr>
<td>Buffer size (MB)</td>
<td>N/A</td>
<td>16</td>
</tr>
<tr>
<td>RPM</td>
<td>N/A</td>
<td>7,200</td>
</tr>
<tr>
<td>Type</td>
<td>N/A</td>
<td>SATA</td>
</tr>
<tr>
<td><strong>Ethernet adapters</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>First network adapter</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Intel I350 Gigabit Controller</td>
<td>Intel I350 Gigabit Controller</td>
</tr>
<tr>
<td>Type</td>
<td>Integrated</td>
<td>Integrated</td>
</tr>
<tr>
<td><strong>Second network adapter</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Broadcom® BCM5709C</td>
<td>N/A</td>
</tr>
<tr>
<td>Type</td>
<td>PCIe</td>
<td>N/A</td>
</tr>
<tr>
<td><strong>Optical drive(s)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>TEAC DV-28SW</td>
<td>TSSTcorp TS-U633J</td>
</tr>
<tr>
<td>Type</td>
<td>DVD-ROM</td>
<td>DVD-ROM</td>
</tr>
<tr>
<td><strong>USB ports</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number</td>
<td>4 External, 1 Internal</td>
<td>4 External, 1 Internal</td>
</tr>
<tr>
<td>Type</td>
<td>2.0</td>
<td>2.0</td>
</tr>
</tbody>
</table>

*Figure 5: System configuration information for the test servers.*
Dell 3-2-1 Reference Configurations: High-availability performance with Dell PowerEdge R720 servers

<table>
<thead>
<tr>
<th>Storage array</th>
<th>Dell EqualLogic PS6100XV</th>
</tr>
</thead>
<tbody>
<tr>
<td>Array</td>
<td>Dell EqualLogic PS6100XV</td>
</tr>
<tr>
<td>Number of storage controllers</td>
<td>2</td>
</tr>
<tr>
<td>Number of active storage ports</td>
<td>4</td>
</tr>
<tr>
<td>Disk vendor and model number</td>
<td>Dell ST9146852SS</td>
</tr>
<tr>
<td>Disk size (GB)</td>
<td>146</td>
</tr>
<tr>
<td>Disk buffer size (MB)</td>
<td>16</td>
</tr>
<tr>
<td>Disk RPM</td>
<td>15,000</td>
</tr>
<tr>
<td>Disk type</td>
<td>SAS</td>
</tr>
</tbody>
</table>

*Figure 6: Detailed configuration information for the storage array.*
APPENDIX B – HOW WE TESTED
SETTING UP THE SHARED STORAGE AND NETWORKING

Setting up the Dell EqualLogic PS6100XV

1. Using the command-line console, via serial cable, reset the Dell EqualLogic PS6100XV by using the reset command.
2. Supply a group name, group IP address, and IP address for eth0 on the array.
3. After group creation, using a computer connected to the same subnet as the storage, use the Dell EqualLogic Web interface to do the following:
   a. Click Start→Internet Explorer, and enter the IP address of the Dell EqualLogic PS Series Group Manager. For our testing, we used 192.10.1.100.
   b. Log into the Group Manager using the factory default credentials.
   c. Expand Members, click the member Storage, and, in the right pane, select the Network tab.
   d. Right-click eth0, and select Modify IP settings.
   e. Enter the desired IP address for the second iSCSI connection, and click OK. For our testing, we used 192.10.1.101 for the IP address and 255.255.255.0 for the Subnet mask.
   f. Right-click eth0, and select Enable interface.
   g. Repeat steps b, c, and d for the remaining iSCSI NIC (eth1, eth2, and eth3), and apply the appropriate IP address and subnet mask. For our testing, we used 192.10.1.102-192.10.104 for the IP addresses, and 255.255.255.0 for the subnet mask. Verify MTU size of 9,000 on each NIC.
4. To create a storage pool, right-click Storage pools, and select Create storage pool (select RAID 10).
5. Create volumes:
   a. In the left pane, click Volumes, and, in the adjacent pane, click Create volume.
   b. Name the volume VirtualMachine1 and click Next.
   c. Type 70 for the Volume size, and click Next. For our testing purposes, we did not create a snapshot reserve with the volume.
   d. On the Step 3 – iSCSI Access screen, click the Allow simultaneous connections from initiators with different IQN names checkbox.
   e. Review the Summary, and click Finish.
6. Repeat step 5 seven times for the remaining volumes, using the following names and Volume sizes:
   - VirtualMachine2 – 70GB
   - VirtualMachine3 – 70GB
   - SharePoint – 250GB
   - Exchange – 500GB
   - ExchangeLog – 100GB
   - SQLData – 250GB
   - SQLLog – 50GB

Creating a VLAN and assigning ports on the Dell PowerConnect 6224 switch

1. Open a Web browser and enter the IP address of the switch. Enter the appropriate login credentials.
2. In the left pane, expand Switching, VLAN, and click VLAN Membership.
3. In the right pane, click Add.
4. Enter the first VLAN ID and Name, and click Apply Changes.
5. Repeat step 4 twice to create the remaining VLANs.
6. When you finish, click Back. The VLAN drop-down menu shows the newly created VLANs.
7. To add a port to a VLAN, select the appropriate VLAN from the drop-down menu, and click the desired ports in the Static row.
8. Click Apply Changes to save the VLAN port assignments.
9. Repeat steps 7 and 8 twice to complete the port assignments for the remaining two VLANs on Unit 1, click to select Unit 2 (the other switch), and repeat steps 7 and 8 for all VLANs.

**SETTING UP THE MANAGEMENT SERVER**

**Adjusting BIOS settings**

We used the latest released BIOS updates on the Dell PowerEdge R620. We enabled Virtualization Technology and installed Windows Server 2008 R2 SP1 with all updates as of 1/13/12.

**Setting up vCenter Server**

1. Add the Service Console to the domain.
2. Insert the vCenter Server 5 DVD.
3. Select Autorun.
4. Select vCenter Server from the list of VMware Product Installers, and click Install.
5. Select English, and click OK. The installer will configure .NET Framework at this point.
6. Click Next.
7. Click Next to accept the End-User Patent Agreement.
8. Accept the License Agreement, and click Next.
9. Enter the User Name and Organization information, leave the License key field empty, and click Next.
10. Select Install a Microsoft SQL Server 2008 Express instance, and click Next.
11. Select Use SYSTEM Account, and click Next.
12. Click OK if an FQDN error message appears.
13. Accept the default destination folders, and click Next.
14. Select Create a standalone VMware Server instance, and click Next.
15. Accept the default ports, and click Next.
16. Accept the default ports for the inventory service, and click Next.
17. At the vCenter Server JVM Memory screen, select Small (less than 100 hosts of 1000 virtual machines), and click Next.
18. Click Install.
19. Click Finish when installation completes.

**SETTING UP THE POWEREDGE R720 HOST SERVERS**

**Configuring vSphere 5 (ESXi) after installation**

1. On the ESXi screen, press F2, enter the root password, and press Enter.
2. On the System Customization screen, select Troubleshooting options, and press Enter.
3. On the Troubleshooting Mode Options screen, select enable ESXi Shell, and press Enter.
4. Select Enable SSH, press Enter, and press Esc.
5. On the System Customization screen, select Configure Management Network.
7. On the IP Configuration screen, select set static IP, enter an IP address and subnet mask, and press Enter.
8. On the Configure Management Network screen, press Esc. When asked if you want to apply the changes, type Y.
9. Complete steps 1 through 8 for the other host server.
CREATING A CLUSTER IN VCENTER SERVER ON THE POWEREDGE R620 MANAGEMENT SERVER

Installing the vSphere client

This can be installed on any Windows-based system for accessibility. For our testing purposes, we installed it on our management server.

1. Insert the vCenter Server 5 DVD.
2. Select Autorun.
3. Select vSphere Client from the list of VMware Product Installers, and click Install.
4. Select English, and click OK.
5. At the Welcome screen, click Next.
6. Click Next to accept the End-User Patent Agreement.
7. Accept the License Agreement, and click Next.
8. Enter the User Name and Organization information, and click Next.
9. Accept the default destination folders, and click Next.
10. At the Ready to Install screen, click Install.
11. Click Finish when installation completes.

Creating a cluster using the vSphere Client

1. Using the vSphere client just installed, connect to the vCenter Server on the management server.
2. Right-click the Service Center, select New Datacenter, and enter a name.
3. Right-click the New Datacenter, and select New Cluster.
4. Enter a name for the cluster in Cluster Features screen, and check the box next to Turn On vSphere HA.
5. Accept the default settings for vSphere HA, and click Next.
6. Select VM and Application Monitoring from the VM Monitoring drop-down menu, and click Next.
7. Select Enable EVC for Intel Hosts, and click Next.
8. Accept the recommended swapfile policy, and click Next.
9. Review the settings in the Ready to Complete screen, and click Finish.
10. Right-click the cluster, and click Add Host.
11. Enter the Host IP address and administrative account credentials for the host, and click Next.
12. At the security alert, click Yes.
13. Review the Host information, and click Next.
14. Do not enter a license key, and click Next.
15. Do not enable lockdown mode, and click Next.
16. Accept the default location for the host’s virtual machines, and click Next.
17. Review the summary, and click Finish.
18. Repeat steps 2 through 17 to add the second ESXi host to the cluster.

Installing the Dell EqualLogic Multipathing Extension Module (MEM) version 1.1 Beta on the ESXi servers

1. Using a file transfer utility, copy the MEM installation ZIP file to each ESXi server.
2. Use the following command to install the Dell EqualLogic MEM beta. Consult the installation and user guide for more details on the VMware MEM integration.

```bash
esxcli software vib install -d membundlename.zip --no-sig-check
```
3. Using the Dell EqualLogic Multipathing Extension Module Installation and User Guide, verify that the MEM is functional on each server.

**Configuring the Dell EqualLogic PS6100XV for access from the host servers**

1. Click Start ➔ Internet Explorer, and enter the IP address of the Dell EqualLogic PS Series Group Manager.
2. Log into the Group Manager using the credentials you created during the Remote Setup Wizard.
3. Click on the Volume VirtualMachine1, click the Access tab, and click Add.
4. Check the Limit access to iSCSI initiator name checkbox, enter the iSCSI initiator name of the first ESXi host server, and click OK.
5. Click the Access tab, and click Add.
6. Check the Limit access to iSCSI initiator name checkbox, enter the iSCSI initiator name of the second ESXi host server, and click OK.
7. Repeat steps 3 through 6 seven times for the remaining volumes:
   - VirtualMachine2
   - VirtualMachine3
   - SharePoint
   - Exchange
   - ExchangeLog
   - SQLData
   - SQLLog

**Configuring the networking on the host servers**

**Configuring VM networking on ESXi**

1. Using vSphere client connect to vCenter Server on the management server, and perform the following steps on each server in the cluster.
2. Add the necessary vSwitch for the network that DVD Store traffic will use:
   a. Click the host, click the Configuration tab, and click Networking.
   b. Click Add Networking.
   c. Choose Virtual Machine, and click Next.
   d. Choose VMkernel, and click Next.
   e. Choose create a vSphere standard switch.
   f. Choose the NIC associated with VM traffic.
   g. Assign the network label and assign IP settings.
   h. Click Finish.

**Configuring the vMotion network**

1. Using vSphere client, connect to vCenter Server on the management server, and perform the following steps on each server in the cluster.
2. Add the necessary vSwitch for the network that vMotion traffic will use:
   a. Click the host, click the Configuration tab, and click Networking.
   b. Click Add Networking.
   c. Choose VMkernel, and click Next.
   d. Choose create a vSphere standard switch
   e. Choose the NIC associated with vMotion traffic, and click Next.
   f. Assign the network label, and check the box Use this port group for vMotion.
   g. Click Next.
h. Assign IP settings, and click Next.
   i. Click Finish.

**Configuring iSCSI networking on ESXi**

1. Using vSphere client, connect to vCenter Server on the management server, and browse to the two servers in the cluster. Perform the steps that follow on each server in the cluster.

2. Add the necessary vSwitches:
   a. Click the host, click the Configuration tab, and click Networking.
   b. Click Add Networking.
   c. Choose VMkernel, and click Next.
   d. Choose create a vSphere standard switch.
   e. Choose the first onboard NIC associated with iSCSI traffic.
   f. Assign the network label, and assign IP settings.
   g. Click Finish.
   h. Repeat steps b through g for the remaining NIC assigned to iSCSI traffic.

3. Add the iSCSI software storage adapter:
   a. Click the host, click the Configuration tab, and click Storage adapters.
   b. Click Add.
   c. Click Add software iSCSI adapter.
   d. Click OK.

4. Configure the iSCSI software storage adapter:
   a. Right-click the iSCSI adapter that was just added to the system, select Properties, and ensure it is enabled.
   b. Inside the iSCSI adapter Properties window, click the Network Configuration tab.
   c. Under VMkernel port bindings, click Add, and add each VMkernel adapter to the VMkernel port bindings list.
   d. Close the iSCSI Initiator Properties window and allow a rescan of the host bus adapter by clicking Yes.

5. Enable jumbo frames in ESXi:
   a. Click the host, click the Configuration tab, and click Networking.
   b. On the first vSwitch used for iSCSI, click Properties.
   c. Select the vSwitch.
   d. Click Edit.
   e. Modify the MTU to 9,000.
   f. Click OK.
   g. In the vSwitch Properties window, choose the VMkernel port.
   h. Click Edit.
   i. Modify the MTU to 9,000.
   j. Click OK.
   k. Click Yes if warned about datastore access.
   l. Click Close.
   m. Repeat steps b through l the remaining NIC dedicated to iSCSI traffic.

6. Access provisioned Dell EqualLogic storage:
   a. Using the Dell EqualLogic Web UI, ensure the volumes are online.
   b. In the vSphere client, click the host, click the Configuration tab, and click Storage adapters.
   c. Right-click the iSCSI software storage adapter, and select Properties.
   d. Click the Dynamic discovery tab.
   e. Click Add.
   f. Enter the Dell EqualLogic group IP address.
g. Click OK.

h. Click Close.

i. Click Yes when prompted to rescan the HBA.

**Configuring the external volumes in VMware vSphere 5**

1. In the vSphere client, select the first host.
2. Click the Configuration tab.
3. Click Storage, and click Add Storage...
4. Choose Disk/LUN.
5. Select the disk, and click Next.
6. Accept the default of VMFS-5 for the file system.
7. Review the disk layout, and click Next.
8. Enter the datastore name, and click Next.
9. Accept the default of using maximum capacity, and click Next.
10. Click Finish.
11. Repeat steps 3 through 10 for the remaining LUNs.

**CONFIGURING THE VIRTUAL MACHINES**

**Creating and configuring the VMs**

1. In vSphere client, connect to the vCenter Server on the management server, and browse to one of the ESXi hosts.
2. Click the Virtual Machines tab.
4. Choose Custom, and click Next.
5. Assign a name to the virtual machine, and click Next.
6. Select the first assigned OS Datastore on the external storage, and click Next.
7. Select Windows → Microsoft Windows Server 2008 R2 (64-bit), and click Next.
8. Click 1 for the number of NICs, select vmxnet3, and click Next.
9. Make the OS virtual disk size the maximum available, select thick-provisioned lazy zeroed, and click Next.
10. Select Edit the virtual machine settings before completion, and click Continue.
11. Choose two virtual processors, and click Next.
12. Choose 4GB RAM, and click Next.
13. Select the iSCSI controller, choose VMware Paravirtual, and click OK twice.
14. Click Finish.
15. Repeat steps 1 through 14 to create two more VMs.
16. Attach the Windows Server 2008 R2 SP1 ISO image to the VM, and install Windows Server 2008 R2 on your VM.

**Installing the operating system on the VM**

1. Insert the installation DVD for Windows Server 2008 R2 SP1 Enterprise into the DVD drive, and attach the physical DVD drive to the VM. Alternatively, use an ISO image and connect to the ISO image from the VM console.
2. Open the VM console on vSphere.
3. At the Language Selection Screen, click Next.
4. Click Install Now.
5. Select Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
6. Click the I accept the license terms check box, and click Next.
7. Click Custom.
8. Click Next.
9. At the User’s password must be changed before logging on warning screen, click OK.
10. Enter the desired password for the administrator in both fields, and click the arrow to continue.
11. At the Your password has been changed screen, click OK.
12. Install the latest VMware Tools package on the VM. Restart as necessary.
13. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
14. Enable remote desktop access.
15. Change the hostname and reboot when the installation prompts you.
16. Create a shared folder to store test script files. Set permissions as needed.
17. Set up networking:
   a. Click Start→Control Panel, right-click Network Connections, and choose Open.
   b. Right-click the VM traffic NIC, and choose Properties.
   c. Select TCP/IP (v4), and choose Properties.
   d. Set the IP address, subnet, gateway, and DNS server for the virtual NIC, which will handle outgoing server traffic. Click OK, and click Close.
18. Repeat steps 1 through 17 to install the operating system on the other two VMs.

Adding the external volumes to the VMs in VMware vSphere 5

1. In the vSphere client, right-click the first VM.
2. Click Edit Settings.
3. Select the Hardware tab, and click Add…
4. Choose Hard Disk from the Device Type list, and click Next.
5. Choose Create a new virtual disk, and click Next.
6. Select Specify a datastore or datastore cluster, and click Browse…
7. Select the datastore from the list, noting the maximum capacity, and click OK.
8. Change the Disk Size to the maximum capacity, noted in step 7, and click Next.
9. Select SCSI (1:0) from the Virtual Device Node drop-down box, and click Next.
10. Review the Ready to Complete summary, and click Finish.
11. Repeat steps 1 through 10 for the remaining volumes.
12. In the VM, add the iSCSI storage:
   a. Start the VM, and click the Server Manager icon in the taskbar.
   b. In the left pane, expand Storage, and click Disk Management.
   c. Right-click the first volume, and choose Online.
   d. Right-click the first volume, and choose Initialize Disk.
   e. Select MBR (Master boot Record) for the partition style, and click OK.
   f. In the right pane, right-click the volume and choose New Simple Volume…
   g. At the Welcome screen, click Next.
   h. At the Specify Volume Size screen, leave the default selection, and click Next.
   i. At the Assign Drive Letter or Path screen, choose a drive letter, and click Next.
   j. At the Format Partition screen, leave the default selection, and click Next.
   k. At the Completing the New Simple Volume Wizard screen, click Finish.
   l. Repeat steps c through k for the remaining VM volumes.
13. Repeat steps 1 through 12 for the remaining VMs, and attach the appropriate volumes.
14. For the first VM only: Copy the pre-created DVD Store backup file to the backup virtual disk.
CUSTOMIZING YOUR VIRTUAL MACHINES

Installing SQL Server 2008 R2 on VM #1

Install an instance of Microsoft SQL Server 2008 R2 by following these steps. This installation walkthrough covers only the installation of the Database Engine and Management Components. For other components outside the scope of this guide, such as Reporting Services, Integration Services, or Analysis Services, see Microsoft documentation at http://msdn.microsoft.com/en-us/library/ms143219(SQL.105).aspx.

1. Connect to vCenter Server with vSphere client, and power on the VM.
2. Log into the virtual machine.
3. Insert the installation DVD for SQL Server 2008 R2 into the appropriate ESXi host server’s DVD drive.
4. Using the VM menu, click the connect/disconnect button for the CD/DVD driver, and select connect to D:, where D: is the letter of the physical server’s DVD drive.
5. Click Run SETUP.EXE. If Autoplay does not begin the installation, navigate to the SQL Server 2008 R2 DVD, and double-click.
6. If the installer prompts you with a .NET installation prompt, click Yes to enable the .NET Framework Core role.
7. At the SQL Server Installation Center screen, click Installation. Click New installation or add features to an existing installation.
8. At the Setup Support Rules screen, click OK.
9. At the Product Key screen, enter your licensing information, if applicable, and click Next.
10. At the License Terms screen, accept the license terms, and click Next.
11. At the Setup Support Files screen, click Install.
12. At the Setup Support Rules screen, click Next.
13. At the Setup Role screen, choose SQL Server Feature Installation, and click Next.
14. At the SQL Server 2008 R2 Feature Selection screen, select the features that your organization requires. We chose the following features for this guide: Database Engine Services, Client Tools Connectivity, Client Tools Backwards Compatibility, Management Tools – Basic, Management Tools – Complete, and Full Text Search. Click Next.
15. At the Installation Rules screen, click Next.
16. At the Instance Configuration, enter the appropriate details for your configuration. For a default instance, leave the defaults selected. For a named instance, enter a new instance name and adjust the file paths as necessary.
17. At the Disk Space Requirements screen, click Next.
18. At the Server Configuration screen, choose the service account, preferably an Active Directory domain account, fill in a password if necessary, and click Next.
19. At the Database Engine Configuration screen, choose an authentication mode. If your legacy servers use SQL Server logins at all, select Mixed Mode. If you exclusively use Active Directory domain accounts in your SQL Server environment, choose Windows Authentication.
20. If you choose to use Mixed Mode authentication, enter a password for the system administrator (SA) account, click Add Current User, and click Next.
21. At the Error Reporting screen, click Next.
22. At the Installation Configuration Rules screen, click Next.
23. At the Installation screen, click Install.
24. At the Complete screen, click Close.
25. After the SQL Server 2008 R2 installation process completes, check Microsoft’s Web site for the latest SQL Server service pack, and install that service pack. At the time we wrote this guide, there were none.
Installing Exchange Server 2010 SP2 on VM #2

Installing .NET Framework 3.5.1 features and Internet Information Services

1. Select Start ➔ Administrative Tools ➔ Server Manager.
2. Click Features.
3. Click Add Features.
4. Select .NET Framework 3.5.1 Features.
5. Click Add Required Role Services.
6. Click Next.
7. Click Next.
8. At the Select Role Services screen, select the IIS 6 Metabase Compatibility, IIS 6 Management Console, Basic Authentication, Windows Authentication, Digest Authentication, Static content compression, and Dynamic content Compression checkboxes, and click Next.
9. At the Confirm Installation Selections screen, click Install.
10. At the Installation Results screen, click Close.

Installing Microsoft Filter Pack 2.0

11. Download the Microsoft Filter Pack 2.0.
12. Run FilterPackx64.EXE.
13. Click Next.
14. Click I accept the terms in the License Agreement, and click Next.
15. When the installation is complete, click OK.

Installing Exchange Server 2010 SP1

1. Click Start, type services and press Enter.
2. Right-click the Net.Tcp Port Sharing service, and click Properties.
3. Change the Net.Tcp Port Sharing startup type to Automatic, and click OK.
4. Open a command prompt, type ServerManagerCmd –i RSAT-ADDS and press Enter.
5. Reboot the VM.
6. Insert the installation DVD, capture the host DVD drive to VM2, and click Setup.EXE when the installation prompts you.
7. The installer should consider steps 1 and 2 complete, and gray them out.
8. Click the link to Step 3: Choose Exchange Language Option.
9. Click Install only languages from the DVD.
10. Click the link to Step 4: Install Microsoft Exchange Server 2010 SP1.
11. Click Next to go past the introduction screen.
12. Accept the license agreement, and click Next.
13. Select No for error reporting, and click Next.
15. Leave the organization name at default (First Organization), and click Next.
16. At the question about client computers running Outlook 2003 and earlier, select Yes, and click Next.
17. Click Next to accept defaults for the Configure Client Access Server external domain screen.
18. At the Customer Experience Improvement Program screen, select I don’t want to join the program at this time, and click Next.
19. If a warning about a lack of SMTP appears after the check finishes, ignore it.
20. Click Install to start the installation process.
21. Once installation is complete, click Finish.
22. Click OK when the installation prompts you to reboot.
23. Click Close.
24. Click Yes to confirm exit.
25. Reboot the VM.

**Configuring Exchange Server 2010 roles**

2. In the left pane, click Microsoft Exchange On-Premises.
3. In the left pane, expand Organization Configuration, and select Hub Transport.
4. In the action pane on the far right, select New Send Connector.
5. Name the send connector SMTP select the intended use as Internet, and click Next.
6. In the Address space window, click Add.
7. In the SMTP Address Space window, type * as the address, ensure that Include all subdomains is selected, and click OK.
8. Click Next.
9. Accept defaults for the next two pages by clicking Next.
10. At the New Connector page, click New to create the connector.
11. Click Finish to close the New SMTP Send Connector wizard.

**Installing SP2 for Microsoft Exchange 2010**

2. Double-click the downloaded file to extract the installation files.
3. Click OK to accept the destination directory for the extracted files.
4. Double-click setup.exe to launch the installer.
5. Click Install Microsoft Exchange Server upgrade.
6. At the Introduction screen, click Next.
7. Accept the terms in the license agreement, and click Next. The Readiness Checks will now run.
8. Install any roles in Server Manager that the Readiness Checks prompt you to install.
9. When the checks successfully complete, click Upgrade.
10. Click Finish, and reboot.

**Creating the tester user**

1. Select Start ➔ All Programs ➔ Administrative Tools ➔ Active Directory Users and Computers.
2. In the Active Directory Users and Computers window, select the server in the left pane, and open Users in the right pane.
3. Right-click a blank area in the Users folder, and select New ➔ User.
4. In the New Object - User window, complete the name fields as you wish (we used first name: test, last name: tester, logon name: tester), and select Next.
5. Enter a secure password (we used Password1), and check Password never expires.
6. In the pop-up information window, click Accept.
7. Select Next to close the New Object – User window.
8. Double-click the new user to bring up the Properties window.
9. Under the Member Of tab, click Add.
10. In the Enter the object names to select dialog box, type Domain Admins; Enterprise Admins; Organization Management select Check Names to verify, and click OK.
11. Click OK to close the User Properties window, and close the Active Directory Users and Computers window.
Configuring the Exchange Server 2010 mailbox role

2. In the left pane of the Exchange Management Console window, select Recipient Configuration; in the right pane, select New Mailbox.
3. In the New Mailbox window, select User Mailbox, and click Next.
4. In the User Type page, select Existing users, and click Add.
5. Select the new account you created earlier, and click OK to add it to the selection box.
6. Click Next.
7. In the Mailbox Settings window, type tester in the Alias textbox, check the box beside Specify the mailbox database rather than using a database automatically selected, and select Browse in the Mailbox database selection.
8. In the Select Mailbox database window, select Mailbox Database, and click OK.
9. Click Next.
10. Click New.
11. Click Finish.
12. In the left pane, expand Organization Configuration, and click Mailbox.
13. Click the Database Management tab.
15. Select the Maintenance tab.
16. Check the Enable circular logging box.
17. Check the box beside This database can be overwritten by a restore.
18. Click Customize next to Maintenance interval.
19. Remove all blue from the boxes so the system will not perform maintenance, and click OK.
20. Click OK.
21. Click OK to any warnings about circular logging being applied after the database is remounted.
22. In the far right pane, click Move Databases.
23. Change the Database file and Log folder path locations to E:\Database\(filename) and F:\Maillogs respectively, and click Move.
24. If the application prompts you to dismount, click Yes.
25. Click Finish.
26. Right-click Public Folder Database, and select Properties.
27. Check the Enable circular logging checkbox.
28. Check the This database can be overwritten by a restore checkbox.
29. Next to Maintenance interval, click Customize.
30. Remove all blue from the boxes so the system will not perform maintenance, and click OK.
31. Click OK.
32. On any warnings about circular logging being applied after the database is remounted, click OK.
33. In the far right pane, click Move Database.
34. Change the Database file and Log folder path locations to E:\Database\(filename) and F:\Publiclogs respectively, and click Move.
35. If the application prompts you to dismount, click Yes.
36. Click Finish.

Installing and configuring the Exchange 2010 mail test client (LoadGen)

To create the mail client, you must install several software components. Before following these instructions, make sure to statically assign an IP address for the client, and join the Active Directory domain.
Installing Windows Server 2008 R2 SP1 Enterprise Edition

1. Insert the installation DVD for Windows Server 2008 R2 SP1 Enterprise into the DVD drive.
2. At the Language Selection Screen, click Next.
3. Click Install Now.
4. Select Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
5. Click the I accept the license terms check box, and click Next.
6. Click Custom.
7. Click Next.
8. At the User’s password must be changed before logging on warning screen, click OK.
9. Enter the desired password for the administrator in both fields, and click the arrow to continue.
10. At the Your password has been changed screen, click OK.
11. Click Start, type change power-saving settings and press Enter.
12. Click Change plan settings.
13. In the Turn off the display drop-down menu, select Never.
14. Click Save changes, and close the Power Options, Screen Saver Settings, and Personalization windows.

To set up this server, we had to install several additional software components. The following subsections detail the necessary installation processes.

Joining the domain

1. Select Start→Control Panel→Network Connections→Local Area Connection.
2. Click Properties.
3. Highlight Internet Protocol (TCP/IP), and click Properties.
4. Select the Use the following DNS server addresses radio button, and enter the IP of the DNS server in the Preferred DNS server field. Click OK.
5. Right-click My Computer, and select Properties.
6. Under the Computer Name tab, click Change.
7. In the Computer Name Changes window, under the Member of section, select the Domain radial box, and type test.local
8. Click OK to start joining the domain.
9. When the window appears asking for a person qualified on the domain, type Tester as the username and Password1 as the password.
10. At the welcome pop-up and the warning that you must reset the computer for the changes to take effect, click OK.
11. At the System Properties window, click OK.
12. When a pop-up appears asking if you want to restart now, click Yes to restart your computer.

Installing Internet Information Services

1. Click Start→Administrative Tools→Server Manager.
2. In the left pane, click Roles.
3. Click Add Roles.
4. Click the Application Server check box.
5. When the Add features required for Application Server? screen appears, click Add Required Features.
6. Click Next.
7. Click Next.
8. At the Select Role Services page for Application Server, click the Web Server (IIS) Support check box.
9. Click Add Required Support Role Services.
10. Click Next.
11. Click Next.
12. At the Select Role Services page for Web Server (IIS), click IIS 6 Management Compatibility, ASP, and CGI check boxes; and click Next.
13. Click Install.
14. Click Close.

**Installing Load Generator**

Download and install Load Generator using all defaults.

**Preparing Load Generator**

1. Log into the mail client using the tester account.
2. Select Start ➔ All Programs ➔ Microsoft Exchange ➔ Exchange Load Generator 2010.
3. When the Load Generator window appears, select Start a new test.
4. Select Create a new test configuration, and click Continue.
5. Change the total length of simulation to 32 minutes.
6. Verify that the account name is tester.
7. In the Specify test settings window, type Password1 as the Directory Access Password and Mailbox Account Master Password, and click Continue with recipient management.
8. Create 1000 users in the Mailbox Database, and click Continue.
9. To accept defaults for Advanced recipient settings, click Continue.
10. In the Specify test user groups window, select the plus sign to add a user group.
11. Change the Client Type to Outlook 2007 Cached, the Action Profile to Average, and the Mailbox size to 100MB.
12. Check the PreTestLogon check box, and click Continue.
13. Leave defaults in Remote configurations, and click Continue.
14. Click Save the configuration file as, and name it 1000-users-averagecfg.xml
15. After saving the configuration file, check the Initialize public store as well checkbox, and click Start the initialization phase (recommended before running the test).

**Backing up the mail database**

On the Exchange virtual machine, after you have set up the LoadGen client and created its initial mail database, back up the database to retain a clean copy for each test.

1. Select Start ➔ All Programs ➔ Microsoft Exchange Server 2010 ➔ Exchange Management Console in the mail server.
2. In the left pane, expand Organization Configuration and Mailbox.
3. In the right pane, right-click Mailbox Database, and select Dismount Database from the menu.
4. At the Do you want to continue? pop-up, click Yes.
5. Right-click Public Folder Database, and select Dismount Database from the menu.
6. At the Do you want to continue? pop-up, click Yes. The red arrow appears when you have dismounted the Public Folder Store.
7. Using Windows Explorer, create a new folder: E:\backup\n8. With Windows Explorer, copy all database and public folder files from E:\Database to E:\backup. This process may take several minutes.
10. In the Exchange Management Console, right-click Mailbox Database, and select Mount Database from the menu.
11. Right-click the Public Folder Database, and select Mount Database from the menu.
Installing SharePoint Server 2010 on VM #3

1. Insert the installation DVD, and capture the DVD drive in the VM session.
2. Launch setup.exe, and click Install software prerequisites.
3. At the Welcome to the Microsoft SharePoint 2010 Products Preparation Tool screen, click Next.
4. Accept the EULA, and click Next.
5. When the prerequisites finish installing, click Finish.
6. On the main SharePoint installation menu, click Install SharePoint Server.
7. Enter your product license key, and click Continue.
8. Accept the EULA, and click Continue.
9. Choose the Stand-Alone server type, and click Install.
10. When the installation finishes, check the box for Run the SharePoint Products Configuration Wizard now, and click Close.
11. On the Welcome to SharePoint Products screen, click Next.
12. On the pop-up warning about services that will need to be restarted during the configuration, click Yes.
13. When the wizard has completed the configuration, click Finish.

Preparing the SharePoint test client

Install Windows Server 2008 SP1 with current updates on the client machine.

Installing Microsoft Visual Studio 2010 Ultimate Edition

2. Double-click vs_ultimateweb.exe to run the installer.
3. Uncheck the box for Yes, send information about my computer, and click Next.
4. If you see a pop-up requiring a Windows Imaging component, click the Windows Imaging Component is Required link.
5. Click Download on the appropriate Imaging component, and choose Run.
6. Accept the EULA, and click Next.
7. Close the pop-up window.
8. Click Next.
9. Accept the EULA, review the components to be installed, and click Next.
10. Choose the Full installation and location for the install, and click Install.
11. Click Finish.
12. Reboot the machine.
14. When the installation prompts you, select General Development Settings, and click Start Visual Studio.

Setting up and running WSSDW 1.0.0.0 Beta

1. Complete the following steps on the Domain Controller machine:
   a. Click Start→Administrative Tools→Active Directory Users and Computers.
   b. Right-click the domain name, and select New→Group.
   c. Enter testdomaingroup1 for the group name.
   d. Repeat steps a-c and create another group named testdomaingroup2
2. Download the following from http://spTesttdatapop.codeplex.com/releases/view/1141:
   - To the SharePoint 2010 VM
     - WSS Data Population Tool RunTime.zip
     - WSS Data Population Tool.chm
3. Complete the following steps on the SharePoint 2010 VM:
   b. Copy the contents of both extracted .zip folders (WSS Data Population Tool Run Time and WSS Data Population Tool Sample) into the root of C:
   c. Right-click on a blank space in C:\, select New, click Text Document and name it data.txt. Ensure that this is in the root of C:.
   d. Rename WSS Data Population Sample File.xml to WSS_Data_Population_Sample_File.xml so that there are no spaces in the name. This will allow for execution of the script from the command prompt.
   e. Right-click WSS_Data_Population_Sample_File.xml, and click Edit to open the document in Notepad. Change any applicable parameters to match the following:
      
      ```xml
      <setproperty NumberOfSiteCollections="100" />
      <setproperty SiteNameBase="testsit" />
      <setproperty NumberOfGroups="2" />
      <setproperty GroupNameBase="testgroup" />
      <setproperty TargetDomain="test.local" />
      <setproperty DomainGroupRoot="testdomaingroup" />
      <setproperty DomainUserName="administrator" />
      <setproperty DomainUserPassword="Password1" />
      <setproperty DesignerGroup="design" AdminGroup="full control" />
      <setproperty NumberOfDocumentLibraries="5" />
      <setproperty DocumentLibraryNameBase1="testdoclib_A" />
      <setproperty NumberOfDocuments="10" />
      <setproperty SourceFileLocation="c:\data.txt" />
      <setproperty DestFile="test" />
      <setproperty NumberOfFileVersions="3" />
      <setproperty DocumentLibraryNameBase2="testdoclib_B" />
      <setproperty NumberOfLists="10" />
      <setproperty ListNameBase="testlist" />
      <setproperty NumberOfListItems="20" />
      <setproperty webpartpath="webpartpagesfolder" />
      ``
   f. Open the command prompt and execute the script by entering the following:
      
      ```cmd
      WSSDW.exe WSS_Data_Population_Sample_File.xml
      ```
4. Complete the following steps on the SharePoint 2010 test client:
   a. Extract the contents of WSS Performance Load Test to C: drive on the SharePoint test client.
   b. Open the WssTransactions folder, then right-click→Edit and modify the following files to match as follows:
      • users.csv
         o Below the text “username,password” enter “test.local\administrator,Password1” and remove the remaining entries.
      • serverUrl.csv
         o Below the text “serverUrl” remove “http://server” and enter “http://VM2” to match the server name of the SharePoint 2010 VM
      • HierarchyManagerUsers.csv
         o Below the text “username,password” remove “domain\username,password” and enter “test.local\administrator,Password1”
   c. Open the WssTestProject.sln file in Visual Studio 2010 Ultimate
   d. If prompted, choose General Development Settings and click Start Visual Studio.
   e. When the installation prompts you, click Next.
   f. Click Finish.
   g. When prompted, leave the Retarget the project to .NET Framework 4. After the project opens, you can retarget it to another Framework or Profile radio button selected and click OK.
   h. Click Close.
   i. In the Solution Explorer pane, scroll to WSSDispForm and double-click on it.
   j. Expand the top menu under WSSDispForm in the left pane, expand Validation rules, and delete the FindText entry that references mysite.aspx.
   k. Click Save.
   l. Repeat steps f-h for WSSHomePage, and WSSSmallDocLibAllItems.
   m. Click Project→Add Load Test.
   n. At the Welcome to the Create New Load Test Wizard, click Next.
   o. Enter Test for the load test scenario name, change the think time between test iterations to 36 seconds, and click Next.
   p. At the load Pattern settings for a load test scenario, select Constant load, enter 200 for the User Count, and click Next.
   q. At the Select a test mix model for the load test screen, click Next.
   r. At the Add test to a load test scenario and edit the test mix, click Add and select the following:
      • WSSDispForm
      • WSSDocHTTPFetch
      • WSSHomePage
      • WSSSmallDocLibAllItems
   s. Click OK.
   t. Ensure that the distribution is set to 25%, and click Next.
   u. At the Network type screen, select LAN, and click Next.
   v. At the Browser screen, click Next.
   w. At the Specify computers to monitor with counters sets during load test run screen, click Next.
   x. At the Review and edit run settings for load test screen, enter 1 minute for the Warm-up duration, enter 30 minutes for Run duration, and click Finish.
Click Run test to start the test.

**CONFIGURING THE DATABASE (DVD STORE)**

**Data generation overview**

We generated the data using the Install.pl script included with DVD Store version 2.1 (DS2), providing the parameters for our 5GB database size and the database platform on which we ran: Microsoft SQL Server. We ran the Install.pl script on a utility system running Linux. The database schema was also generated by the Install.pl script.

After processing the data generation, we transferred the data files and schema creation files to a Windows-based system running SQL Server 2008 R2 SP1. We built the 5GB database in SQL Server 2008 R2, and then performed a full backup, storing the backup file on the C: drive for quick access. We used that backup file to restore on both servers between test runs. We performed this procedure once.

The only modification we made to the schema creation scripts were the specified file sizes for our database. We explicitly set the file sizes higher than necessary to ensure that no file-growth activity would affect the outputs of the test. Besides this file size modification, the database schema was created and loaded according to the DVD Store documentation. Specifically, we followed the steps below:

1. We generated the data and created the database and file structure using database creation scripts in the DS2 download. We made size modifications specific to our 5GB database and the appropriate changes to drive letters.
   a. We transferred the files from our Linux data generation system to a Windows system running SQL Server.
   b. We created database tables, stored procedures, and objects using the provided DVD Store scripts.
   c. We set the database recovery model to bulk-logged to prevent excess logging.
   d. We loaded the data we generated into the database. For data loading, we used the import wizard in SQL Server Management Studio. Where necessary, we retained options from the original scripts, such as Enable Identity Insert.
   e. We created indices, full-text catalogs, primary keys, and foreign keys using the database-creation scripts.
   f. We updated statistics on each table according to database-creation scripts, which sample 18 percent of the table data.
   g. On the SQL Server instance, we created a ds2user SQL Server login using the following Transact SQL (TSQL) script:

   ```sql
   USE [master]
   GO
   CREATE LOGIN [ds2user] WITH PASSWORD=N'','
   DEFAULT_DATABASE=[master],
   DEFAULT_LANGUAGE=[us_english],
   CHECK_EXPIRATION=OFF,
   CHECK_POLICY=OFF
   GO
   ```
   h. We set the database recovery model back to full.
i. We created the necessary full text index using SQL Server Management Studio.

j. We created a database user and mapped this user to the SQL Server login.

k. We then performed a full backup of the database. This backup allowed us to restore the databases to a pristine state relatively quickly between tests.

**Editing the workload script – ds2xdriver.cs module**

A new feature of DVD Store version 2.1 is the ability to target multiple targets from one source client. We used this functionality, and in order to record the orders per minute output from each specific database target, we modified the ds2xdriver to output this information to log files on each client system. To do this, we used the StreamWriter method to create a new text file on the client system, and the WriteLine and Flush methods to write the relevant outputs to the files during the tests.

After making these changes, we recompiled the ds2xdriver.cs and ds2sqlserverfns.cs module in Windows by following the instructions in the DVD Store documentation. Because the DS2 instructions were for compiling from the command line, we used the following steps on a system with Visual Studio installed:

1. Open a command prompt.
   a. Use the cd command to change to the directory containing our sources.
   b. Execute the following command:

   ```
   ```

**Running the DVD Store tests**

We created a series of batch files, SQL scripts, and shell scripts to automate the complete test cycle. DVD Store outputs an orders-per-minute metric, which is a running average calculated through the test. In this report, we report the last OPM result reported by each client/target pair.

Each complete test cycle consisted of the general steps listed below. For each scenario, we ran three test cycles, and report the median outcome.

1. Clean up prior outputs from the host system and all client driver systems.
2. Drop all databases from all target VMs.
3. Restore all databases on all target VMs.
4. Shut down all VMs.
5. Reboot the host system and all client systems.
6. Wait for a ping response from the server under test (the hypervisor system), all client systems, and all VMs.
7. Let the test server idle for one hour.
8. Start the DVD Store driver on all respective clients.

We used the following DVD Store parameters for testing the virtual machines in this study:

```shell
ds2sqlserverdriver.exe --target=<target_IP> --ramp_rate=10 --run_time=34
--n_threads=20 --db_size=5GB --think_time=0.3
```
ABOUT PRINCIPLED TECHNOLOGIES

We provide industry-leading technology assessment and fact-based marketing services. We bring to every assignment extensive experience with and expertise in all aspects of technology testing and analysis, from researching new technologies, to developing new methodologies, to testing with existing and new tools.

When the assessment is complete, we know how to present the results to a broad range of target audiences. We provide our clients with the materials they need, from market-focused data to use in their own collateral to custom sales aids, such as test reports, performance assessments, and white papers. Every document reflects the results of our trusted independent analysis.

We provide customized services that focus on our clients' individual requirements. Whether the technology involves hardware, software, Web sites, or services, we offer the experience, expertise, and tools to help our clients assess how it will fare against its competition, its performance, its market readiness, and its quality and reliability.

Our founders, Mark L. Van Name and Bill Catchings, have worked together in technology assessment for over 20 years. As journalists, they published over a thousand articles on a wide array of technology subjects. They created and led the Ziff-Davis Benchmark Operation, which developed such industry-standard benchmarks as Ziff Davis Media’s Winstone and WebBench. They founded and led eTesting Labs, and after the acquisition of that company by Lionbridge Technologies were the head and CTO of VeriTest.